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OFFICERS & COMMITTEE 2010-2011



      SPS CLUB EVENINGS
Wednesdays - September to April inclusive

at 7:30pm
The Bowls Pavilion

The Castle Outdoor Bowls Club
Albion Street, Spalding PE11 2AJ

The Club caters for a range of skills, from beginner to advanced,
using film and digital. In addition to the winter programme, outings
and events are also arranged on an occasional basis during the
summer break.

SPS ANNUAL SUBSCRIPTIONS

Single Adult  £25 per annum

Joint Membership  £40 per annum

Students/Full Time Education  £5 per annum

Visitors  £2

SPS AFFILIATION
Photographic Alliance of Great Britain (PAGB)

North and East Midlands Photographic Federation (NEMPF)

Lincolnshire Photographic Association(LPA)
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SEPTEMBER 2011
7th  The season’s opening evening - welcome back
  Introduction to the new Programme 2011-12
  Reminder of PDI requirements for competitions
  Our LPA Battles print images from 2011
14th Jim Hartje ARPS DPAGB APAGB EFIAP BPE5*
        ‘My Photography’ - Fine Art & Creative Expression
  Images before and after computer processing

Deadline for 1st Aggregate (Prints & PDI)
21st  Neil Smith
  ‘Local Wildlife’ - A newcomer to lecturing presents
        a collection of wildlife images from his local area
28th Competition night - 1st Aggregate (Prints & PDIs)
  Judge: Dave Stewart  LBPPA

OCTOBER 2011
5th  Ashley Franklin ARPS APAGB ABPPA
  ‘From Pursuit to Passion to Profession’
  Slides & digital presentation chronicling progress from
  camera club photographer to a professional career
12th Nancy Ford
  ‘The Western Isles’ - A slide presentation illustrating the
  landscape, flora & antiquities of these islands from the
  Butt of Lewis to Vatersay on Barra

Deadline for ‘3 on a Theme’ (Prints & PDIs)
19th Liz & Barrie (DPAGB) Hatten
  ‘Florida & Wyoming’
  DPI presentation with live commentary
26th Competition Night - ‘3 on a theme’ (Prints & PDIs)
  ‘Open Theme’
  Judge: John Whaler
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NOVEMBER 2011
2nd  Paul Machin’s Studio Evening - ‘High Key Lighting’
  Various ways to achieve this, using different setups
  Hands on - bring your camera

Deadline for 2nd Aggregate (Prints & PDIs)
  Deadline for ‘Question Time’ requests
9th  Jean Brumby - ‘Photoshop Workshop’
  Beginners Plus - notes supplied after the workshop
16th Competition - 2nd Aggregate (Prints & PDIs)
  Judge: Daphne Hanson CPAGB APAGB
23rd RPS Nature Group 2011 Exhibition
  Digital presentation of RPS Members work on Nature
  Photography from around the globe

Deadline for ‘4 on a Theme’ & ‘Audio Visual’
  & ‘Junior’ competition entries
30th Question Time - Answers to members’ questions on all
  aspects of photography with illustrations/demonstrations
  Submit written questions by 2nd November deadline

DECEMBER 2011
7th  Competition Night
  4 on a Theme Print Competition - ‘Architecture’
  Audio Visual Competition & Junior Competition
  Judge: Alan Davey
15th Roger Human’s Fun Night
  An evening of quizzes and seasonal refreshments

CHRISTMAS BREAK
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The committee wishes all members of Spalding Photographic
Society a very joyful Christmas and a healthy and very
prosperous new year in 2012



JANUARY 2012
4th Paul Machin’s Studio Evening
  Low Key Lighting / Creative / Artistic - Various setups
  giving different results - Hands on, bring your camera

Deadline for 3rd Aggregate (Prints & PDIs)
11th Paul Bowker
  ‘Raw Power’ An insight into how shooting Raw can
  give us tremendous control over our images, with many
  advantages that are difficult to ignore
18th Competition - 3rd Aggregate (Prints & PDI)
  Judge: Adrian Stone
25th NEMPF 2012 Exhibition - Tonight we host Pinchbeck

Digital presentation of dramatic landscapes, portraits
  and nature in monochrome & colour.

FEBRUARY 2012
1st  Graham Heywood DPAGB EFIAP/g ABPE
  ‘Imaginations’ - A Digital image presentation of
  something for all - Sport - Creative - Travel
8th  Members images throughout the year - Prints & PDIs
  from the current year with some members talking about
  why and how they created their images
15th Dave Stewart LBPPA ‘ProShow Gold Workshop’
  Demonstration on how to make digital Audio Visuals
  Plus a collection of AVs

Deadline for Annual Print entries
22nd David Bratley
  ‘One Man Band’ - how this image was created
29th Competition - Annual Prints
  Judges: Liz & Barrie (DPAGB) Hatten
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MARCH 2012
7th  Colin Lusby CPAGB
  ‘Art for the Untalented’
   Darkroom and digital mono and colour prints

Deadline for Annual PDI entries
14th David & Stephanie Bratley
  Quiz Night
  Another great evening of fun competition
21st  Competition - Annual Projected Digital Images
  Judge:
  Jim Hartje ARPS DPAGB APAGB EFIAP BPE5*
28th Adrian Stone

‘Cuban Adventures’ A slide presentation

APRIL 2012
4th  Annual Awards Evening
11th Annual General Meeting

The next club evening will be on Wednesday 5th September
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ANNUAL PRINT EXHIBITION
APRIL 2012

The Geest Gallery
Ayscoughfee Museum, Spalding, Lincolnshire

Wednesday 4th April to Sunday 29th April
Set up - 10 am  Monday 2nd April

Removal - 10 am Monday 30th April



Trophies and certificates will be awarded to
PDI of the Year

Print of the Year
Best Advanced Print

Best First Timers Print
1st Timer Aggregate - Prints

Best Four on a Theme - Prints
Advanced Aggregate - Prints & PDIs

Best Three on a Theme - Prints & PDIs
Best Audio Visual Presentation - Digital Images

Certificates will be awarded to
the following open awards
Best Nature - Prints & PDIs
Best Portrait - Prints & PDIs
Best Creative - Prints & PDIs
Best Landscape - Prints & PDIs
Best Monochrome - Prints & PDIs
Best Sports & Action - Prints & PDIs
Best Pictorial & Record - Prints & PDIs

Junior Awards
Members Children/Grandchildren

Age groups: 6  to 10  & 11 to 16
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AWARDS & TROPHIES

PDIs -  Projected Digitally Images



ANNUAL WINNERS 2010/2011

PRINTS
Best Natural History           Ray Harrison
Best Pictorial & Record                       Paul Clifton
Best Landscape                                     Paul Clifton
Best Portrait                                                        Paul Machin
Best Creative                                                        Steve Jones
Best Sports & Action                                          Dennis Pegram
Best Monochrome                                                Paul Clifton
Best First Timer Steve Jones
Best Advanced                                                      Paul Machin
Chairman’s Theme Paul Smith
Advanced Aggregate  (3 x 3)                              Paul Bowker
First Timers Aggregate  (3 x 3)                       Dennis Pegram
Three on a Theme                                                   Alan Dolby
Four on a Theme                                              Steve Marriott
Print of the Year         Paul Machin

PROJECTED DIGITAL  IMAGES (PDIs)
Best Natural History                                                Alan Dolby
Best Pictorial & Record                                          Paul Bowker
Best Landscape                                                   Shaun Barnard
Best Portrait                                                       Gordon Francis
Best Creative                                                         Paul Smith
Best Sports & Action                                            David Bratley
Best Monochrome                               Dennis Pegram
Chairman’s Theme                                               Len Challis
Aggregate (3 x 3)                                                    Paul Smith
Image of the Year Alan Dolby
Three on a Theme                        Paul Smith
Best Audio Visual Paul Bowker

JUNIOR COMPETITION
6 - 10 Year                            Ben Lilley (Paul Bowker)
11 - 16 Year                                                              No entry
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CLUB COMPETITION RULES
GENERAL

•   Annuals - prints & projected digital images (PDIs)
    A maximum of 6 images in each medium in categories.
•   Aggregates - prints & projected digital images (PDIs)
    A maximum of 3 images in each category medium round.
•  In the event of the scores being level after all rounds of an
 aggregate competition, a winner shall be determined by the
 greater number of high scores between the members involved.
• There will be no duplication of the same image in prints nor
 projected digital images in the same competition.
• No print nor projected digital image shall be entered for the
 same competition more than once unless substantially
 altered by heavy cropping, toning or additional treatment.
• A minimum of two participants is required to qualify a
 Competition.
• Restrictions - no print nor projected digital image (PDI)
 shall be more than 3 years old and must be the sole work of
 the author.
• Three on a Theme competition - a maximum of 2 sets of
 prints & projected digital images (PDIs) can be entered and
 there will be a winner in each format. Prints each to be
 mounted on separate boards.
• No one print nor projected digital image (PDI) shall win
 more than 2 awards at an annual competition (ie 2 open
 awards). The only exception shall be for Print of the Year or
 Projected Digital Image (PDI) of the Year.
• A First Timer will be deemed ‘Advanced’ on winning two
 annual awards.
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PRINTS
• Prints must be mounted on substantial board not larger than
 20” x 16” nor smaller than 10” x 8”.
• Four on a Fixed Theme competition - a maximum of 2 sets
 of prints can be entered. Prints should be mounted on a
 single board of any size. Maximum print size 7” x 5”
• Entry submission: Two weeks before competition

AUDIO VISUAL PRESENTATIONS
• AV competition entries must consist of a self executable file.
 e.g. Pictures to Exe or ProShow Gold
• The sequence must run with no additional software
 requirements.
• All photographic images must be produced solely by the
 author and set to a soundtrack of the author’s choice.
• The duration of the sequence must not exceed 5 minutes.
• A maximum of two sequences per entrant.
• Entry submission: Two weeks before competition

JUNIOR COMPETITION
• The Junior competition is open to the children and
 grandchildren of club members.
• Prints to be 6” x 4” mounted on card 10” x 8” and solely the
 work of the entrant.
• Entries should be titled and a maximum of 2 per child.
• Age categories: 6 - 10 years & 11 - 16 years
• Entry submission: Two weeks before competition
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PROJECTED DIGITAL IMAGES (PDIs)

REQUIREMENTS

• Mode: RGB Colour 8 bits only or Greyscale 8 bits only
• Colour space:  sRGB
• Image size:  Maximum 1024 pixels wide x 768 pixels tall
• Resolution: 72 ppi (pixels per inch)
• Format: JPEG
•      File name: Title in capitals-Author-Competition/Category
•      Entry submission: Two weeks before competition
• Competition entries are required to meet this criteria, with
 images in a folder & filed in the order the author wishes
 them projected.

RESIZING DIGITAL IMAGES FOR PROJECTION

It’s good practice to work on an image copy and not the original.

The following process is using any version of Adobe  Photoshop
or Elements.

All digital images will be judged at a resolution of 1024 x 768
pixels. The 1024 is the width across, making the image a land-
scape format.

Firstly, you should resize your image to fit within that pixel area.
You will probably want to maintain the proportions of your image,
so you should add a black background to fill any remaining space.
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RESIZING THE IMAGE
1. From the Image menu, choose Image Size, the Image Size
dialogue box is displayed. Select Resolution of 72 pixels per inch.
2. Make sure the units you have selected are pixels (top centre of
the box).
3. Enter the width you want, for example 1024.
The height will adjust automatically providing you have the
Constrain Proportions box ticked.
4. Finally, check the height, if the height is more than 768, then
you need to enter 768 in the height – this will reduce the width to
less than 1024 pixels. Click OK.

Remember:
Select Resolution of 72 pixels per inch first.
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ADDING A BACKGROUND TO THE IMAGE

If your image is not exactly 1024 x 768 then it will be judged with
a black background filling the remaining space. With the resized
image from the previous steps 1 to 4 completed:

1. Set the background colour on the colour palette to black.

2. From the Image menu, choose Canvas Size. The Canvas Size
dialogue box is shown. Do not tick the Relative box.

3. Make sure the units are set to pixels. Type in 1024 for the width
and 768 for the height.

4. Click OK. Your image canvas is now enlarged to show the
picture and the spare margins around the outside.
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SAVING THE IMAGE
Always use 'Save As’and never save over the original

1. To save a file as a JPEG file, from the File menu, choose Save
As. The Save As dialogue is then displayed.
2. Select the folder you want to save to. Type in the correct File
name (remember, it must show the file title followed by your
name and category. You can use spaces, or replace spaces with
underscore if you want to). Next make sure the Format field is set
to JPEG.
3. Click the Save button, you'll then see the JPEG Options
dialogue box. (As below)
4. Set the amount of compression to apply to the image. You can
set the Quality to 10 or 11 and that's fine. This will ensure the
final file size is not too large but will retain the quality of the
image. Make sure the Format Options is set to Baseline
(“Standard”). Click OK.

By following these notes you will go a long way to ensuring that your
images will be displayed as you intend them to be.
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INTERNAL COMPETITION PLANNER

To enable the relevant organiser sufficient time to prepare for
the competition night, please adhere to the above deadlines.
If unable to attend on the deadline date, please arrange with the
relevant organiser to bring in entries on an earlier date.

For the Annual Print & Annual PDI competitions please ensure
your entries are submitted for the right category, as previous
judges have marked down  entries where errors have occurred.

NOTES

16

DEADLINE EVENT MEDIUM MAX ENTRIES
14 Sep 2011 1st Aggregate Print & PDI 3 per medium
12 Oct 2011 3 on a Theme Print & PDI 2 sets per medium
02 Nov 2011 2nd Aggregate Print & PDI 3 per medium
23 Nov 2011 4 on a Theme Print 2 sets
23 Nov 2011 Junior Comp Print 2 prints
23 Nov 2011 Audio Visual Digital 2 sequences
04 Jan 2012 3rd Aggregate Print & PDI 3 per medium
15 Feb 2012 Annual Print Print 6 prints
07 Mar 2012 Annual PDI PDI 6 PDIs



CATEGORY DEFINITIONS

1. NATURE: Shall include natural history, domestic animals,
cultivated plants, zoological and geological.

2. LANDSCAPE: Shall include a variety of environments, seas,
skies, cities, countryside, urban and industrial.

3. PORTRAIT: Shall include close up, head and shoulders, three
quarter and full length images, small groups or individuals, posed
or un-posed. To include human subjects only.

4. RECORD: Shall include any building or part of a building,
ancient or modern, and objects or furnishings belonging to or
associated with the subject. Shall include archaeological or other
inanimate objects. eg motor vehicles, ceramics etc.

5. PICTORIAL:  Shall include any photographs of a pictorial
nature e.g. Landscape, seascape, abstract, texture, still life or table
top.

6. CREATIVE: Shall include the use of  manipulative techniques
to produce an image with the use of imaginative skill or originality
of thought including the altering of reality.

7. SPORT & ACTION: Shall include any team or individual
sport, and any image depicting movement or action

8. MONOCHROME:  Shall include all black and white images,
also black and white images which have been modified by the
addition of a single tone to their entire image.

n.b.    Record & Pictorial are linked in the Annual competition
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COMPETITION DIARY

DATE COMPETITION COMMENTS
28.09.11 1st Aggregate - Print
28.09.11 1st Aggregate - PDI
26.10.11 3 on a Theme - Print
26.10.11 3 on a Theme - PDI
16.11.11 2nd Aggregate - Print
16.11.11 2nd Aggregate - PDI
07.12.11 4 on a Theme - Print
07.12.11 Audio Visual
07.12.11 Junior
18.01.12 3rd Aggregate - Print
18.01.12 3rd Aggregate - PDI
29.02.12 Annual  Print - Nature
29.02.12 Annual  Print - Pictorial & Record
29.02.12 Annual  Print - Landscape
29.02.12 Annual  Print - Portrait
29.02.12 Annual  Print - Creative
29.02.12 Annual  Print - Monochrome
29.02.12 Annual  Print - Sport & Action
21.03.12 Annual  PDI - Nature
21.03.12 Annual  PDI - Pictorial & Record
21.03.12 Annual  PDI - Landscape
21.03.12 Annual  PDI - Portrait
21.03.12 Annual  PDI - Creative
21.03.12 Annual  PDI - Monochrome
21.03.12 Annual  PDI - Sport & Action

Good Luck
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USEFUL LINKS

www.pagb-photography-uk.co.uk
The Photographic Alliance of Great Britain

www.nempf.org
North and East Midlands Photographic Federation

www.lpauk.org
Lincolnshire Photographic Association

www.loxleycolour.com
Professional printers for digital photographers.

www.proamimaging.com
Online digital prints - excellent service at a good price

www.wnsoft.com
Picture to Exe. audio visual software.

Downloadable free trial version.

www.photodex.com
ProShow Gold audio visual software

Downloadable free trial version.

www.beckhamdigital.co.uk
Barry is well known for his Photoshop & Audio Visual

Tutorials - plus lots of info and freebies.

www.russellbrown.com
Adobe designer’s own website

Lots of Photoshop tutorials to view and download.
You could get lost forever here!
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1. The name of the Society shall be the Spalding Photographic
 Society, but may be referred to as Spalding Camera Club.

2. The objects of the Society shall be to promote and stimulate
 the science and art of photography in all its’ branches.

3. The Officers of the society shall consist of a  Chairman,
 Secretary, Treasurer and Programme Secretary who shall
 be elected annually at the Annual General Meeting of the
 Society from the members. The officers of the Society, the
 past Chairman and Vice Chairman shall be ex officio
 members of the Committee. Three other members from the
 Society shall be elected by members from the floor at the
 Annual General Meeting.
 The Committee shall have the power to appoint and change

when required, nominees for investment purposes, who must
be paid up members of the Society.

4. The Committee shall have the power to co-opt any member
to the Committee and shall be further empowered to
nominate members to form Sub-Committees for special
purposes.

5. No member of the Society shall be eligible for election as an
Officer of the Society or as a Committee member if his or her
subscription shall be in arrears as defined in these rules.
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CONSTITUTION



6. The financial affairs of the Society shall be managed by
the Treasurer and cheques shall bear two of the signatures
of Treasurer, Secretary and/ or one other member of the
Committee. The Bankers of the Society shall be such Bank
nominated by the Treasurer.

 a.     The Treasurer shall present the annual accounts
  in audited form at the AGM. If not audited, such
  accounts are to be audited within 28 days of the
  said AGM and then filed with the Secretary.

 b.  The audit shall be carried out by a member of
  the Society who will not be an Officer or
  Committee Member of the Society.

7. The Secretary shall maintain a Register of Members and
keep the minutes of all meetings of the Society and
perform such other secretarial duties as shall, from time to
time, be assigned to him by the Committee.

8. a.         The annual subscription to the Society shall be
  determined by the Committee and confirmed at
  a General Meeting.
b. Joint membership shall be limited to married

couples or partners.
c. Reduced subscriptions shall be available to

persons partaking in full time education.
d. All subscriptions shall be due on the first day of

September in every year and paid by the Thirtieth
day of September in that year.

e.  Persons joining the Society after 1st January
  shall pay half subscription to the end of the
  current programme.
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9. Members whose subscriptions shall be unpaid for six
months after the due date in any year shall be deemed to
be in arrears & shall be liable to be struck off the Register
of Members under the power confirmed by Rule 10.

10. A member whose subscription is in arrears or whose
membership of the Society for any other good and
sufficient reason shall be deemed undesirable and shall be
liable to expulsion by a majority vote of members at a
special meeting convened for the purpose.

11. The business meetings of the Society shall comprise the
Annual General Meeting to be held in April or May each
year and such Extraordinary General meetings as shall
from time to time be convened in accordance with Rule 13.

12. Seven clear days of notice in writing shall be given to all
members of the Annual General Meeting and of any
Extraordinary General Meetings.

13. At Committee meetings a minimum of five of the
members and ex officio members shall form a quorum. At
General Meetings one fifth of the members whose names
shall appear on the Register of Members for the time being
shall form a quorum.

14. An Extraordinary General Meeting of the Society may be
convened on a requisition signed by ten members of the
Society, addressed to the Secretary, stating the nature of
the business or proposition to be brought forward.
Within 28 days from the receipt of such a requisition, the
Secretary shall convene an Extraordinary General Meeting
in the manner prescribed by Rule 12.
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15. If, at any General meeting of the Society, a resolution
for the dissolution of the Society is passed by a majority
of the members present, the Secretary shall, within
21 days,  convene an Extraordinary General Meeting
within one calendar month. If at any such Extraordinary

 General Meeting, not less than one half of the members
entitled to vote at general meetings are present, and the
dissolution is confirmed by a two-thirds majority, the
Committee shall immediately proceed to realise the
property of the Society, and after discharge of all
liabilities shall divide such property rateably among
all persons comprising the then membership. On
completion of such divisions the Spalding Photographic
Society shall be dissolved.

16. No alteration, amendment or addition to these Rules
shall be made except at the Annual General Meeting or
an Extraordinary General Meeting specifically
convened for the purpose, such alteration, amendment
or addition to be notified to members in writing together
with the original Rule if any, with the notice of the
meeting as required in Rule 12.
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